
 

 

 

THE USE OF DIGITAL CONTENT FROM ONLINE LIBRARIES AND PUBLISHERS FOR BRAILLE PRODUCTION 
 

A Guide for Braille Presses of India 

Annex – Rules for Math Equations 

 

IMPORTANT NOTE: 
 

Do not use the following methods for inserting Math expressions & symbols into a Microsoft Word file: 

 Do not Insert Math Symbols or Expressions directly from Microsoft Word’s “Insert Equation & Symbols” feature, shown below; 

 

 Do not Insert Math Symbols or Expressions directly from the “Symbols” section found on the MathType ribbon, shown below; 



 

 

 



 

 

 

 
 

It is important to follow the list of rules below. Failure to follow these rules may result in errors in the Braille file that are hard to spot and that 
could result in the equation being read aloud or transliterated to Nemeth Braille incorrectly. 

 

Rule #1. All Mathematical Expressions should be inserted with MathType. This does not include plain numbers that are 

not part of a Math expression. 

 

Here are some instances:  
Example 1:+ 
Plain numbers appearing independently in a book will not be typed in MathType. Example: 
“Ram bought 50 pencils.” 
Here, 50 is not typed in MathType. 

 
Example 2: 
Mathematical expressions in which all the symbols are available on the keyboard will also be typed in the MathType box. 

 
 

Example 3: 

 
Note: In the above equations, the words “ones” and “tens” will be written in style: Text and with a space before and after the words. This is 

discussed further in a later point. 

Example 4: 

 
Example 5: 

Rules for Typing & Editing Math Equations 



 

 

 

 

Example 6: 

Example 7: 

Example 8: 

 

3x =  this is incorrect cause 3x is not typed in MathType 
3x  

2  
this is correct, where the entire expression is typed in MathType 

 

Note: In the above equations the colon/ratio sign, the greater than sign, the plus sign etc. are typed from the keyboard but in the MathType 

window. As some symbols like ratio sign, plus, minus, greater than, less than etc. have no special symbol in the MathType window, these are 

typed directly from the keyboard. 



 

 

 

 

Rule #2: You do not have to add spaces within Mathematical expressions in the MathType window. 
 

Example: 
In the MathType window, when typing “y=” you do not have to type a space between the “y” and the “=” because MathType takes care of 
the spacing automatically. To help break the habit of adding spaces, the spacebar is disabled most of the time in MathType, so pressing it will 
have no effect other than producing a beep sound! 

 

Rule #3. For any text appearing within an equation, type the text in MathType and choose “Style: Text”. 
 

Note that the default style in the MathType window is “Math”. This is displayed at the bottom of the window, as shown in the image below. 

 

 

Example 1: 
Numerator 

Deno min ator 

Here the style of the text above would need to be changed to “Text” from “Math”. 

Select the word “Numerator” & “Denominator” and choose Style as “Text”, as shown below. 



 

 

 

 

Numerator 

The corrected equation will appear like this - Denominator 

 

Example 2: 

 

The default Style setting is “Math” 

Select the words “ones” and “tens” and select Style: Text 

It will then appear like this 

 

Press control space when keeping the cursor before “ones” and before “ten” and after “ten”. (This spacing is discussed again in a later point) Example 3: 

   

Select ‘Prob’ and choose Style > Function 

Select the word "both", and choose Other from the Style menu. The Other Style dialog will appear, which lets you directly change the font and 

style (bold & italic) of selected characters. Click on Bold, and then choose OK. 



 

 

 

 

Rule #4. The MathType Equation box in the Word file should be treated as you would treat a word with appropriated 

spacing before and after it. 

 

i.e. One space should be left before and after the MathType equation box at all times, except: 

- if the equation is followed by a punctuation mark (since no space is kept before a punctuation mark at all times) 
or 
- if the equation is at the end of the line or the start of a line (since no space is given after the last word on a line or before the first word on 
the line) 
 

(g) 12 

A space will be given after “(g)” and before the mixed fraction begins. 

 

Example 2 

Is 8 5 ? 

A space will be given between the word “Is” and the MathType expression, no space will be given between the MathType equation and “?” 



 

 

 

 

Rule #5. For text and punctuation marks within MathType equations, spacing should be as per the rules of English. 
 

To add a space within a MathType equation, press “ctrl key + spacebar”. 
Example 1: 

2 
,   

5 
,   

6 
, 

3 
7 7 7 7 

One space is given after the comma. 

 

Rule #6. Handling Punctuation Marks within MathType equations. 
 

When dealing with punctuation marks – commas, full stops, exclamation marks, etc. – within equations, note the following: 
- Spacing of punctuation marks should be as per Grammar rules; i.e. no space before punctuation marks, but one space after if followed by 
text or an equation. 
- When we change the Style of the punctuation mark to “Style: text”, we must manually insert a space after the punctuation mark if it is to 
be followed by anything. 
(The spacing within equations is automated and correct only when using “Style: Math”) 
- Punctuation within a Math expression should always be inside the MathType box with the style for that punctuation selected as “Style: 
Text”. 
**The Full Stop/Period is the exception to this rule. Keep the full stop outside the MathType box without any space before it, otherwise it will be 
considered a decimal point. 

 

Example 1: 
10 10  1, 

Here, the comma is typed in the MathType window and the Style for the comma is selected as 
“Text”. There is no space before the comma in the MathType window. 

 

Example 2: 

1 
1 
 

10 
?
 

6 8 

Here, the question mark is typed in the MathType window and the Style for the question mark is selected as “Text”. 



 

 

 

There is no space before the question mark in the MathType window. 
 
Example 3: 

2  3  4, 3! 
Here, the question mark is typed in the MathType window and the Style for the question mark is selected as “Text”. 
There is no space before the question mark in the MathType window. 
(However, when the exclamation mark is used to signify the Mathematical concept of factorials, this should be left as “style: Math”. In case you 
are unsure of the context in which the exclamation mark is used, please check this with Shizanne) 

 

IMPORTANT NOTE: 
The Full Stop is the exception to this rule. Keep the full stop outside the MathType box without any space before it, otherwise it will be 
considered as a decimal point. 

 

Rule #7. For Units of measurement – m, cm, l, ml, kg, etc) – within MathType equations, select the style as “Text” and 
insert a space before and after the units of measurement. 

 

Example: 
2 m  3m 



 

 

 

 

Rule #8. For blanks within a MathType equation, type the question mark and not 3 hyphens or 1 underscore. Here, 
the question mark is left as “Style: Math”. 

 

Example: 

1 
2 
 

_ 
3 9  is wrong 

1 
2 
 
 

is wrong 
3 9 

1 
2 
 

? 
is correct 

3 9 

 

Rule #9. It is fine to type several equations in the same MathType window. However, do not type full text sentences 
or phrases in the MathType window. 

 

Example  1: 
This is allowed: 

 
 

Avoid this: 

The adjacent pair of angles whose sum is 180 is called a linear pair. Here BAC  CAD 180 



 

 

 

This is correct, where only 180 and BAC  CAD  180 is in MathType as shown below; 

 

The adjacent pair of angles whose sum is 180  is called a linear pair. Here BAC  CAD  180 

 

Rule #10. Algebraic Variables and Names for Geometry figures that are a part of Math Equations must be typed in 
MathType with the style left as “Math”. 

 

- Type in the MathType box and leave style as 
“Math”. Example: 
AB  BC 

 

Rule #11. When typing a single letter / variable that is not a part of a Math Equation, it need not be typed within the 
MathType equation window. However, two or more letters together must be typed within a MathType equation and 
left as “Style: Math”. 

 

Example: 

A and B are two points on segment AB. 

Here “A” and “B” are typed outside MathType. 
However “AB” is typed within MathType. 



 

 

 

 

 

Rule #12. When selecting superscript and subscript in most cases we choose the first superscript / subscript symbol 

option. 



 

 

 

 

 

Rule #13. Point your cursor to the symbol and check the symbol name at the bottom of the MathType window as 

shown below before inserting the symbol. 

 

 

 

 

 

 

 

 

 

 

 



 

 

 
 

Rule #14. Underline numbers in MathType as shown below, not by using Microsoft Word’s underline feature. 
 

Option 1 
 

 

or 

Option 2 

 



 

 

 
 

Rule #15. Use the strikethrough option from the MathType window as shown in the image below only. 

 

 
Do not use the strikethrough option shown in the image below; 

 



 

 

 
 

 
 

 1. Customizing the Toolbar 
The Toolbar can be customized to show symbols you use often in the licensed MathType version. 
The expressions in MathType’s tabbed bars can be inserted into the equation you are working on with just a single click. 
To add your own expression to a bar, drag it to the desired spot. 
To modify an equation on the bar, double-click on it to open it in its own editing window. To 
delete an expression from the bar, right-click and choose Delete. 

 

 2. Keyboard shortcuts 
Quick Shortcut keystrokes when typing in the MathType window 
As you hold the mouse pointer over the palette items, their names as well as the shortcut keystroke to access them are displayed in the status bar at 
the bottom of the MathType window. This will help you make sure you pick the correct template and remember the shortcut key to access them as 
well. Example: 
You can also create a superscript slot by typing Ctrl+H ("H" = "high"). 
Ctrl+L inserts a subscript slot ("L" = "low"). 
Ctrl+F inserts the slot for typing a Fraction, and so on. 
Ctrl+Shift+E to change style to text 

Ctrl+9 for round brackets (parentheses) 

Ctrl+[ for square brackets 

Ctrl+R for radical sign (square root sign) 
Greek Characters - You can enter a Greek character using Ctrl+G and its equivalent letter, e.g. m for   , P for  , d for  . 

Some More Shortcuts & How to’s 



 

 

2C 
 

 3. Copying and Dragging 
To re-use part of an existing equation, select the part and then use Copy and Paste, or drag and drop. Hold down the Ctrl key when dragging to copy 
the selection. 

 
 4. To type something like 

Keep the cursor before C and select the superscript slot and type 2 in it. Next keep the cursor after C and select the subscript slot and type 1. 

 5. To type Spatial Math Sums 
To type all spatial Math sums as well as Long Division sums etc. use the Matrices option in MathType as shown below. To create a matrix, use the 
“matrix templates,” and select the variable-size matrix, shown below. This will allow you to create the matrix with as many rows and columns as 
needed. 

 

 
Example: 

The equation below was created using a 3 by 5 matrix, with the top two cells in column one being unused. 



 

 

 

 
 

 

 6. Instructions for typing Long Division sums 
A long division sum can be typed out in MathType using the fraction template, as shown. 

 
You can use tabs underneath the long division sum to line up the numbers. The tabs are the arrows, of which the one used below is the furthest to 
the left, to be clicked and dragged along the ruler to the desired position. Next, if you press Ctrl + Tab on the keyboard, it will bring the cursor to 
the desired position. 
Learning how to use tabs is a course in the MathType Help (Help > MathType tutorials). It can be found by using the index to search for 
“Formatting with tabs.” 



 

 

 

In order to get the line underneath the “0”, use the under-bar template in row 2 column 6. Also, the line spacing will need to be lowered. It can be 
found in the “Format > Line Spacing” menu. 

    51 

654 952 

 0 

95 

 

 7. To type Cross Multiplication 
Cross Multiplication, as shown in the image below, can be typed using MathType and should be treated as spatial Math. 
In Microsoft Word, you can type out the cross multiplication sign based on the template shared by Design Science. Please contact staff for this. 

 



 

 

 8. To Insert a Pascal Triangle 
1. Insert a matrix: 

 
2. Dimension the matrix thus: 

# of 1s along a side 2  #s along the base – 1 which, for this one, is 5 rows, as there are 5 ones along the left or right side, and 11 

columns, since there are 6 numbers along the base, so times 2 is 12, and minus 1 is 11. What you see above, therefore, is a 5x11 matrix. 

Before you close the Matrix dialog, make sure Row Alignment is Baseline, Column Alignment is Center, and Equal Column Widths is 

checked. 

 
3. Type the numbers inside in the way that works for you, but a good technique is to start by typing a 1 in the bottom cell of the first column, 

proceeding diagonally up and to the right, typing 1 in each cell along that diagonal until you get to the top row. Proceed downward and to the 

right the same way. Now fill in the middle, skipping a column between each entry. 

 
4. When you are finished, it will still not look right – as it will be too spaced out. The one above looked like this at this point: 

1 

1 1 

1 2 1 

1 3 3 1 

1 4 6 4 1 

1 5 10 10 5 1 



 

 

 

5. You can fix this in MathType by expanding the Format menu and clicking the bottom entry: Define Spacing. You must change 3 items in 

the Define Spacing dialog: 

Change Matrix row spacing to 100% 

Change Matrix column spacing to 1% 

Uncheck the box labeled “Use for new equations”. 

When you click OK, the triangle should look more normal. Like all templates in MathType, the green dashed rectangles are only to show 

you where the template slots are, and do not show up in Microsoft Word. 

 9. To cancel several items together, choose the option in the image as shown below; 

 
 

 10. The numbers above or below a cancelled number will be written as superscript or subscript numbers, as shown 
below; 

1 

11  
 

3  
 

11 
 1 

1 

15 5 2 10 10 

(n  x) ! 

(n  x)!25 



 

 

 

 11. For expressions with large brackets, use the brackets/parenthesis from the MathType (Ctrl + 9) and not directly 
from the keyboard. 
Example: 

8 
2 
 
 

4 
5 

of 343  3 
2  

1 
4 
 ? 

9 
   

7 3 
 

5 

 





 

 





 12. To insert Slanting Cross lines, as shown below; 
Example: 

 

and 



 

 

 

 
Decision: It can be done in MathType, but it won’t be accessible. Therefore, we will create it as a graphic, and add the alt text. 



 

 

 13. To Insert Circled Numbers; 

Example: 

 

 
How to insert in MathType: 

For the circled numbers, the user would need to produce a circle and then nudge (move) the number inside of it. MathType can use a circle from any 

font. If there is a font on the computer that is being used that contains a circle, therefore, it can be used to produce the circle. We recommend using 

the “Insert Symbol” dialog, which is found in the “Edit” drop down menu. Select “Insert Symbol” and then change the “View by:” drop down menu to 

“Description.” Click the “New search…” 



 

 

 
button to search for “circle.” The results will show up below, and then click the desired circle and click “Insert.” It will insert the circle into the 

MathType editor. 

 
 

 

Once the circle is in the MathType editor, it can be highlighted, and then clicked and dragged into an empty place on the MathType toolbar for 

future use. 



 

 

 

 

 

Once the circle is in the MathType editor, it is possible to enter the number, size it (ctrl + > or ctrl + < ), and then nudge (move) the number into the 

circle. To nudge the number into the circle, highlight the number and then hold the ctrl key, and press the directional arrow keys on the keyboard to 

nudge (move) it into place. 



 

 

 

 

 

 14. To insert long division with the quotient to the left; 
Example: 

 



 

 

 

How to: 

You can use the open or close parenthesis, or use the long division template that we have available below for the rounded long division signs after 

the number “55224” and before the “2”. 

 
To achieve the line underneath the “110448,” the user would use the “underbar template.” 

 

The tab functionality, which is explained in the MathType tutorial – the arrows directly above the workspace – is used to align the numbers. They 

must be dragged down to the ruler in order to be used. After a tab has been inserted, the “ctrl + tab” shortcut is used to tab over to the tab position. 

This is how the equation is aligned properly. 



 

 

 

 

 
55224)122012 (2 

110448 



 

 

 

 

 

 

Handling Math Expressions & Symbols – in the E-Copy 

The E-copy remains the same as the Master copy. Nothing changes here. 

 

Handling Math Expressions & Symbols – in the Braille Ready Word File 
1. Handling Spatial Math Sums 
Let all spatial Math sums be in MathType, as inserted in the Master copy. However add the following below the sum: 
- To represent the horizontal line for the answer: Below the MathType equation in the Word file, type “3” ten times below the equation to 
represent the horizontal line, where needed. 
Example: 

9, 9 9, 9 9 9 

 1 

1 0, 0 0, 0 0 0 

3333333333 
3333333333 
- To represent the horizontal line for carry over: If there is any kind of carry over in the sum, type “7” ten times below the equation. 
- For all other spatial Math (Long division, matrices etc.) leave them in MathType. 

 

Handling Math Expressions & Symbols – in the DBT file (Internally) 
 

1. Spatial Math Alignment (long division, cancellation with fractions, cross multiplication etc) and removing and adding braille symbols as required. 
2. Check & Correct spacing for Large Numbers that are written in the Indian place value system and that are a part of Math expressions. 

*** 
 


